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OVERVIEW


INTRODUCTION

The Outcome Assessment Information Set (OASIS) was developed by the Centers for Medicare & Medicaid 
Services (CMS) to set a standardized protocol for assessing the clinical characteristics of Home Health 
Agency (HHA) patients. This information is used to better support the regulatory process and policy-making 
by providing survey agencies with a mechanism for objectively measuring facility performance and quality. It 
also is used to support a prospective payment system for HHAs. In addition, it provides researchers with a 
rich set of information to support the development of improved standards of care through the study of patient 
care outcomes. 

The purpose of the OASIS National Automation Project is to provide computerized storage, access, and 
analysis of the OASIS data on HHA patients across the U.S. The OASIS System consists of several 
interrelated components, including data communications and an OASIS National Data Repository, and is 
intended to create a standard, nationwide system for connecting HHAs to their respective State agencies for 
the purpose of electronic interchange of data, reports, and other information. 

To achieve these goals, CMS has sponsored the development of a data entry system known as the OASIS 
Home Assessment Validation and Entry (HAVEN) System. HHAs can use HAVEN for collecting OASIS 
data in a standardized format and electronically creating OASIS data records to be sent to State agencies. 

As of OASIS Version 1.30 (Reduced Burden) a number of changes to the assessments reduce the 
number of OASIS items required to be entered for some assessment types. In particular, assessment types 
04 (Recertification) and 05 (Other Follow-Up) primarily include those items required to calculate the HIPPS 
code. Furthermore, assessment types 02 and 10 have been eliminated. 
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CONVENTIONS


Standard conventions have been adopted in the HAVEN System Reference Manual to facilitate locating and 
identifying desired information. These conventions and their definitions include the following: 

Bolded Title Case	 Windows, screen titles, program functions, variable names, and 
dialog boxes (e.g., the HAVEN Patient Information screen). 

Title Case and Italicized	 Text box or list box descriptions (e.g., the Select an Employee list 
box). 

Title Case Menu options (e.g., the General Help menu option). 

<CAPITALS>	 Menus, buttons, icons, and function keys (e.g., the HELP menu, 
the <CANCEL> button, the <NOTES> icon, and the <T> key). 

Bolded User entered data (e.g., Enter the password HAVEN). 

Information Symbol. This symbol indicates that the user should 
take notice of the information. 

Exclamation Point Symbol. This warning symbol indicates that 
an action has been selected that may have undesirable results. 
The warning provides an explanation and asks for verification 
before continuing with the selected action. 
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QUICK START


INSTALLATION AND START UP


This section discusses the following topics: 

• Hardware/Software 
• Installation 
• Help 

HARDWARE/SOFTWARE


To operate HAVEN, the following hardware and software are required: 

• IBM or IBM-compatible personal computer with Pentium 200 MHz or higher processor 
• VGA or VGA-compatible display monitor with a minimum resolution of 800x600 pixels 
• Hard disk with a minimum of 40 megabytes of available space 
• 32 megabytes of RAM 
• CD-ROM drive (if installing from CD) 
• Microsoft Windows 95, 98, ME, NT, 2000, or XP 
• Microsoft or Microsoft-compatible mouse or pointing device 

HAVEN was designed using Super VGA resolution (800x600). At a lower resolution (e.g., 640x480), 
all of the variables on a given screen may not be visible. Use the scroll bars to view the entire screen and 
perform data entry. 

INSTALL THE HOME ASSESSMENT VALIDATION AND ENTRY 
(HAVEN) SYSTEM APPLICATION 

Detailed installation instructions are contained in README.TXT. This file is located in the root directory of 
the HAVEN Installation CD. For the Internet version of HAVEN (downloaded from the CMS OASIS web 
site), extract the contents of the downloaded ZIP file (SETUPHAVEN62.ZIP) into a temporary directory (e.g., 
C:\TEMP). This action will decompress all of the installation files as well as README.TXT. 

Run the SETUP.EXE program to begin the installation and follow the steps to install the HAVEN program. 
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Operating HAVEN within Large Agencies


HAVEN Version 1.0 was intended to provide software to agencies who either: 1) could not afford to purchase 
software from a vendor and/or 2) did not require a full-featured, client/server application that would be 
integrated with existing systems. As such, Version 1.0 was designed as a stand-alone application and was 
not intended to run in a network environment. Version 1.0 was designed to run on the Windows 3.1 platform 
for agencies that could not upgrade to Microsoft Windows 95, 98, 2000, or XP. Consequently, HAVEN was 
built using the Visual Basic 4.0 development environment and Microsoft Access 2.0 databases for storage. 
These two technologies place limits on the software in terms of performance and capacity. 

Since the release of Version 1.0, demand for HAVEN by large agencies has increased significantly. Large 
agencies have requirements that could not be met by Version 1.0; specifically, running in a network 
environment and entering a large number of assessments. 

Recent releases of HAVEN were designed to address these two issues as follows: 

•	 The HAVEN storage database can now be located on a shared, network drive. This capability allows 
multiple installations of the software to perform data entry against the same database. For more 
information, see the section below titled “Installing HAVEN in a Network Environment.” 

•	 HAVEN now includes archive/restore functionality. This functionality alleviates the burden on the 
primary storage database and allows HAVEN to operate in a high-capacity environment. However, 
this functionality does not operate automatically and requires tasks to be performed by the System 
Administrator. For more information, see the section titled “Archive Setup.” 

•	 HAVEN can utilize Microsoft Access 2.0 or Microsoft Access 97 databases; however, HAVEN does 
not currently support Microsoft Access 2000 or higher databases. 

Nevertheless, HAVEN should not be mistaken for a network application. HAVEN is still a stand-alone 
application, but now contains features that make it possible to operate in a network environment, under 
limited circumstances. Microsoft Access is not a full-featured Relational Database Management System 
(RDBMS). Although steps were taken to address collisions in the software, collisions that cause application 
errors may still occur. In addition, a high number of records in the storage database will degrade the 
performance and reliability of the system. 

To ensure the best possible operation of HAVEN under a network environment and limit the number of 
collisions against the database, the following steps should be taken: 

• Assign one user to perform all data entry for a particular patient; 

•	 Assign one user to perform all maintenance of the patient information including the adding and 
deleting of patients; 

• Assign one user to perform all maintenance of the agency and employee information; 

• Assign one user to perform all imports and exports; 

• Assign one user to perform all archiving and restoring; 

• Assign one user to create all reports; 

•	 Do not perform maintenance on the patient, employee, and agency information while other users are 
performing data entry; 
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• Do not perform imports and exports while other users are performing data entry; 

• Do not perform archiving and restoring while other users are performing data entry; and 

• Do not perform report creation while other users are performing data entry. 

•	 Utilize the Archive/Restore functionality regularly to alleviate the burden on the storage database. In 
addition, be certain to compact the storage database (HHA.MDB) after every archive. 

Installing HAVEN in a Network Environment


Several steps should be followed when installing HAVEN in a network environment. These steps are: 

•	 For the first PC, install the HAVEN software. First-time users should then copy the HHA.MDB 
storage database from the installation directory to a shared network drive; for upgrade installations, 
users can skip this step since the HHA.MDB will already exist on the network drive. 

•	 Run HAVEN. On the Preferences screen, click on the Paths tab and enter the HHA.MDB location. 
HAVEN will then exit immediately. Restart HAVEN and then set up the agency and employee 
information. 

•	 For each subsequent PC, install the HAVEN software. Run HAVEN. On the Preferences screen, 
click on the Paths tab and enter the HHA.MDB location. Restart HAVEN and confirm that the 
software is utilizing the shared HHA.MDB. 

When setting up a network configuration, a shared drive on a network file server MUST be used. Do 
not use a shared local drive on a PC since a peer-to-peer configuration is not supported. 

HELP


General/About Help


The General Help provides HAVEN system help regarding how to use and maintain the HAVEN software. 
About help identifies HAVEN software and data dictionary Version information as well as application and 
storage database (HHA.MDB) path locations. From the HAVEN Management Screen or any of the HAVEN 
Data Entry screens, click on the HELP menu and select either the General Help or the About option. 

Additional Help


Context sensitive help is available from any window by pressing the <F1> key. Individual variable help is 
also available (on data entry screens) by right mouse clicking anywhere within a variable's frame on the data 
entry screens. 
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LOG IN


The user can log in to the HAVEN software by entering the user identification and password in the User ID 
and Password text boxes, respectively. To exit the HAVEN Login screen without actually logging in to the 
system, click on the “X” in the upper right corner of the screen. 

USER IDS


Use the following Login identification and password for HAVEN the first time: 

• User ID HAVEN and password HAVEN are the defaults. 
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HAVEN PATCHES


The HAVEN Patches screen will be displayed if HAVEN detects that a patch(es) is required. Click on the 
<OK> button to execute the patches or click on the <CANCEL> button to exit HAVEN. 

It is highly recommended that a backup of the HAVEN databases be performed prior to execution of 
these patches. Click the <CANCEL> button if any uncertainty exists about whether the data was saved and 
perform a backup procedure. Users can then re-enter HAVEN and click the <OK> button on the HAVEN 
Patches screen. 
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After the patches are completed, review the items in the Status Messages box for additional information on 
the nature of the patches. Click on the <PROCEED> button to continue into HAVEN. 

DATABASE MAINTENANCE


For a new HAVEN installation, the following message box will be displayed. 

Agency information must be entered before any other functions can be utilized. From the 
ADMINISTRATION menu item, select the Maintain Agency Database option. Once the HAVEN Agency 
Information screen is completed, the user Login identification and password can be added, modified, or 
deleted by using the Maintain Employee Database  feature within the HAVEN software. 

After installation, it is recommended that the System Administrator log in first, using HAVEN as both 
the User ID and password. After completing the Agency information, the System Administrator should 
establish a new User ID and Password for the System Administrator account. This step can be 
accomplished by using the Maintain Employee Database  function described in System Setup. The HAVEN 
account should then be deleted to ensure the security of the HAVEN software. 
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SYSTEM SETUP


MAINTAIN AGENCY DATABASE


The Agency Database collects agency and agent information. It is accessed from the main menu by 
selecting the ADMINISTRATION menu item and then either choosing the Maintain Agency Database option 
or clicking the <MAINTAIN AGENCY DATABASE> icon on the button bar. 

The HAVEN Agency Information screen collects the agency and agent information used to customize the 
operation of the HAVEN software. It is recommended that a user with System Administrator rights complete 
this information after installation.  This screen is divided into two sections: Agency Information and Agent 
Information. 
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AGENCY INFORMATION


The Agency Information section enables the user to specify unique agency-identifying information such as 
Agency Name, Address, Contact Person, and Medicare, Medicaid, and State-specified provider numbers. 
Fields shown in bold are required. 

When an assessment is created, five agency fields are copied from the agency database into the 
assessment record. These five fields are: Agency State Assigned Unique ID; Agency Medicare Provider 
Number (M0010); Agency Medicaid Provider Number (M0012); Branch State (M0014); and Branch ID 
(M0016). Because agency information can be edited at any time, the existing assessment records (except 
non-key field corrections) are not automatically updated when changes are made to the Agency fields. 
However, HAVEN will ask the user whether all unexported assessments should be updated. 

HAVEN will first ask if the Agency fields should be updated. It is recommended that this update be 
completed to maintain the integrity of the export files. Then, HAVEN will ask whether the Branch fields 
(Branch State and Branch ID) should be updated. The answer to this question depends on whether the 
current installation of HAVEN is being used for a single branch or for an agency with multiple branches. 

If HAVEN is being used for a single branch, then the user will want to enter the Branch fields here for 
use as default values in assessments. However, if HAVEN is being used for an agency with multiple 
branches, then the Branch fields should be left blank, since each assessment will have different branch 
information and the Branch fields on the assessment are enabled during data entry. 

Upon entering a ZIP Code for Agency and Agent Information, the city and state will be automatically 
looked up if a valid ZIP code is entered. If needed, users may overwrite the value. 

AGENT INFORMATION


The Agent Information section collects unique agent data such as tax identifier, name, address, and phone 
number. 

The Agency Information and Agent Information data are included as header information for each export 
from the HAVEN software. Information about HAVEN export capabilities is provided in the Export Section. 
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MAINTAIN EMPLOYEE DATABASE


The Employee Database provides centralized management of the employee records used continuously in 
the entry of assessment data. It also provides the capability to customize the HAVEN software. The 
database is accessed from the main menu by selecting the ADMINISTRATION menu item and then 
choosing the Maintain Employee Database option, or from the button bar, by clicking on the <MAINTAIN 
EMPLOYEE DATABASE> icon. 

Note that this screen is only accessible to users with System Administrator rights. After installation, the user 
(authorized as System Administrator) will want to define the expected users of the HAVEN software. The 
HAVEN Employee Information screen is used to collect employee identi fication and authorization 
information. This screen consists of two sections: Select an employee and Enter Employee Information. 
The Select an employee list box consists of the User IDs for all employees currently defined in the database. 
When the user clicks on a specific User ID, that ID is highlighted and the corresponding employee data is 
displayed in the Enter Employee Information text boxes. 

The user may: 

•	 Add a New Employee Record.  Click on the <NEW> button to add a new employee record. The 
required fields (User ID, Password, and Authorization) must be completed. Upon completion of the 
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Employee Information section, click on the <SAVE> button to update the employee database. This 
action will also refresh the Select an employee list box to display the new user. 

•	 Edit an Existing Employee Record. Select an employee record and then click on the field or check 
box of interest to edit the data. Clicking on the <SAVE> button will save all changes made to the 
employee record to the database. Clicking on the <CLOSE> button and then clicking on <YES> to 
the pop-up question “Are you sure you want to close and lose any changes?” will abandon all 
changes made to the employee record since the last save. 

•	 Save All Changes made to an Employee Record. Click on the <SAVE> button to save all 
information entered for a new or existing employee record. 

•	 Delete an Employee Record.  Click on the <DELETE> button to remove the currently selected 
employee record from the database. Note that when a System Administrator is logged in as 
him/herself, he/she cannot delete his/her own User ID. He/she must log in as another System 
Administrator and then delete his/her User ID. 

Since the System Administrator has access to all functions of the HAVEN software, the user is 
prevented from deleting the last System Administrator from the database or changing the rights (from 
System Administrator to Data Entry or View Only) for the last System Administrator. 

•	 Cancel All Edits to an Employee Record.  Click on the <CLOSE> button and then answer <YES> 
to the pop-up question “Are you sure you want to close and lose any changes?” to abandon all 
changes made to the employee record since the last save. 

•	 Assign Authorization Rights.  The Authorization radio buttons - Data Entry, System Administrator, 
and View Only - determine the level of access for the currently selected employee. When adding an 
employee record, the Authorization field must be specified. 

•	 Data Entry Rights.  Users are able to edit Agency information, add/edit Patient database 
information, add/edit assessments, review assessments performed by other users, perform data 
entry for all HAVEN forms, view HIPPS, and view/print reports. 

•	 System Administrator Rights.  Users are able to add/edit/delete Employee database information, 
add/edit/delete/hide/unhide Patient database information, edit Agency information, 
add/edit/correct/delete assessments, review assessments performed by other users, perform data 
entry for all HAVEN forms, view HIPPS, view/print reports, import/export files, specify preferences, 
specify archive setup information, and archive/restore patients. 

•	 View Only Rights.  Users are able to review assessments performed by other users, view HIPPS 
codes, and view/print Reports. 

MAINTAIN PATIENT DATABASE


The Patient Database provides centralized management of the patient information records that will be used 
continuously in the entry of assessment data. It also provides the capability to customize the operation of the 
HAVEN software. The database is accessed from the main menu by selecting the ADMINISTRATION menu 
item and then choosing the Maintain Patient Database option or by clicking on the <MAINTAIN PATIENT 
DATABASE> button on the button bar. 
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The HAVEN Patient Information screen collects patient information that is reused in HAVEN assessments. 
This screen consists of two sections: Patient Selection and Patient Information. 

The Patient Selection section on this screen is similar to the Patient Selection section on the HAVEN 
Management Screen. The only option available in the Patient Selection section on the HAVEN 
Management Screen is the capability to add a patient. Any maintenance (i.e., edit/delete) for a patient 
record must be completed through the Maintain Patient Database menu option. 

The Patient Selection section allows the user to select or search for a patient in the same manner as the 
HAVEN Management Screen. The list of patients is sorted by last name, but can be re-sorted by clicking 
on the column headings. Once a patient is selected, the corresponding data appears in the Patient 
Information text boxes. This section consists of data entry fields for demographic and identification 
information such as gender and birth date. The information collected here will be utilized to pre-fill the 
corresponding fields on the HAVEN assessment records for the selected patient. 

When an assessment is created, all of the patient fields are copied from the patient database into the 
assessment record. Since patient information can be edited at any time, the existing assessment records 
are not automatically updated. When changes are made to any of the patient fields, HAVEN will ask the user 
whether all unexported assessments (except for non-key field correction assessments) should be updated. It 
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is recommended that this update be completed to maintain consistent patient information across 
assessments in the export files. 

If the Patient ID Number (M0020) is changed for each new episode, it is recommended that the user 
NOT update all unexported assessments (except for non-key field correction assessments) unless they are 
associated with that episode. For example, if 10 assessments exist for an episode with a Patient ID Number 
of 12345A and a new episode starts and the Patient ID Number is changed from 12345A to 12345B, the 
existing unexported assessments (except for non-key field correction assessments) should not be updated 
with the new Patient ID Number. 

Patients are displayed 100 at a time in the patient list. To view the next 100 patients in the list, select 
the <NEXT 100> button. The <PREVIOUS 100> button will display the previous 100 patients. 

ZIP codes that (a) are not five or nine digits long, or (b) contain letters, are no longer rejected in the 
patient ZIP code field (M0060); instead a warning is provided to the user. If letters or a short ZIP code are 
entered and the user clicks on the <SAVE> button, the warning “M0060 Zip Code is not 5 or 9 digits long 
or contains letters. Do you wish to continue?” appears. Clicking on the <YES> button allows the user to 
continue and save the entered information. Clicking on the <NO> button returns the user to the Patient 
Information screen. Upon entering a valid ZIP Code for Agency and Agent Information, the state will be 
automatically populated. If needed, users may overwrite the value. 

The items M0072 (Primary Referring Physician ID), M0140 (Race/Ethnicity), and M0150 (Current 
Payment Sources for Home Care) were added to the patient information screen in HAVEN Version 6.0 and 
are now tracked by patient. To help complete these items for patients who already exist, items M0072 and 
M0140 are copied during data entry from the assessment if the values for the patient are blank. HAVEN 
asks the user if M0150 should be updated, since payment sources can vary from assessment to 
assessment. If Unknown is checked for item M0150, the value will only be copied to Start of Care and 
Resumption of Care assessments, since the Unknown option is inactive for other assessment types. 

From the Patient Information Screen, the user may: 

•	 Add a New Patient Record.  Click on the <NEW> button and begin entering data in the Enter 
Patient Information section. All of the fields, excluding Patient First Name, Middle Initial, Suffix, 
and Unique Patient ID Code (State Provided), must be completed before the record can be saved. 
Click on the <SAVE> button to save the new patient record when data entry is complete. The user 
will be prompted with a message to “Save new patient currently displayed.” Click on the <YES> 
button to save the changes or the <NO> button to cancel the changes. 

HAVEN will not allow duplicate patient records. Duplicate records are identified by: 

• Same first name, last name, date of birth, and gender; 

• Same Medicare or Medicaid number; 

• Same Social Security Number; 

• Same Patient ID number (M0020); or 

• Same State Provided Patient ID. 
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•	 Edit an Existing Patient Record.  Select a patient record and then click on the field or check box of 
interest to edit the data. Clicking on the <SAVE> button will save all changes made to a patient 
record in the database. Clicking on the <CLOSE> button and clicking on <YES> to the pop-up 
question “Are you sure you want to close and lose any changes?” will abandon all changes made to 
the patient record since the last save. 

•	 Save All Changes made to a Patient Record.  Click on the <SAVE> button to save all information 
entered for a new or existing patient record. 

When saving a new patient or saving changes to an existing patient, a warning will be provided if 
invalid data is entered or if mandatory data is not completed. 

•	 Delete a Patient Record.  Only a System Administrator may delete a patient record. Select a 
patient record to delete and then click on the <DELETE> button. Two messages will appear before 
the patient record and all the assessments associated with that patient will be deleted from the 
database. 

Once a patient record is deleted from the database, it cannot be recovered! 

•	 Hide/Unhide a Patient Record.  A patient record may only be hidden/unhidden by a System 
Administrator. Select a patient record to hide and then click on the <HIDE/UNHIDE> button. To 
view a hidden patient record, click on the Include Hidden Patients check box. (Patients with a “Y” in 
the ‘H’ column of the patient list are hidden patients.) To unhide a patient record, highlight a patient 
record and click on the <HIDE/UNHIDE> button. 

•	 View Archived Patient Records.  To view archived patient records, click on the Include Archived 
Patients check box. (Patients with a “Y” in the ‘A’ column of the patient list are archived patients.) 
Highlight an archived patient record and the name of the archive database containing assessments 
for the patient will appear in a field below the Include Archived Patients check box. Note that 
archived patient data cannot be edited. 

•	 Cancel All Edits to a Patient Record.  Click on the <CLOSE> button and then click on <YES> to 
the pop-up question “A re you sure you want to close and lose any changes?” to abandon all 
changes made to the patient record since the last save. 

ENABLE BACKUP


HAVEN has the option to make a backup copy of the data collection databases (e.g., HHA.MDB, 
EXPORT.MDB, and the current archive database) each time the user exits HAVEN normally. If these 
databases are corrupted due to abnormal termination of HAVEN (e.g., power failure, system lockup) and 
cannot be repaired, the System Administrator can copy the backup databases into the installation directory 
and only the last HAVEN session will be lost. 

To enable the backup, the System Administrator may select the ADMINISTRATION menu, click on the 
PREFERENCES option, and select the Backup tab on the HAVEN Preferences window. The user can then 
specify a directory location for the backup files. 
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The backup directory cannot be the same directory where the application and databases currently 
reside. 

A backup path MUST be provided or the backup option will be disabled. Once a path has been specified 
and HAVEN is exited, the data will be backed up to the designated directory in the specified compression 
format. If <No compression> is selected, then the files are copied to the designated directory. If <Enable 
compression of databases to ZIP format> is selected, then a ZIP file named HHAMDB.ZIP will be created in 
the designated directory. Similarly, if <Enable compression of databases to self-extracting EXE> is selected, 
then an executable named HHAMDB.EXE will be created in the designated directory. 

The second time a HAVEN session is exited, the previously backed-up files will be moved to the installation 
path for the HAVEN software. Note that for the <No compression> option, the files will be compressed to 
HHAMDBBACK.ZIP; for the <Enable compression of databases to self-extracting EXE> option, the file will 
be copied and renamed HHAMDBBACK.ZIP; and for the <Enable compression of databases to self-
extracting EXE> option, the file will be copied and renamed HHAMDBBACK.EXE. From that point forward, 
the process will repeat itself, supplying the user with the HAVEN databases from the two most recent 
sessions. 

The backup process should be completed to a network drive, a removable disk, a CD, or a diskette (for 
smaller files). If possible, do not backup the files to a user's local hard drive only. 

If the backup path is later deleted or renamed (e.g., the directory name is changed/deleted using Windows 
Explorer), HAVEN will notify the user upon exiting the system that the backup failed because the path no 
longer exists. 

The HAVEN Backup capability is no substitute for a comprehensive backup strategy. It is HIGHLY 
RECOMMENDED that HAVEN users institute a regular procedure of backing up the databases to a reliable 

HAVEN System Reference Manual: September 1, 2003 System Setup � 16 



media (e.g., floppies, removable disk, and tape). For additional suggestions regarding backup, read the 
Backup section of the HAVEN Help Desk Notes (HELPDESK.PDF) located in the application directory. 

WINDOWS SETTINGS


In order to ensure the reliable operation of the HAVEN software, it is imperative that the following Windows 
property be set properly: 

For Microsoft Windows 95, 98, ME, NT, 2000, and XP, the Windows Font Size property must be set to 
“Small Fonts” and not “Large Fonts.” This property can be found under the Settings tab of desktop 
properties. 
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HAVEN DATA ENTRY


HAVEN MANAGEMENT SCREEN


Once HAVEN has been loaded, a number of functions can be performed. These functions are all activated 
from icons or drop down menus available on the screen. 

The HAVEN Management Screen consists of the following components: 

• Title Bar.  Displays the title HAVEN Management Screen. 

•	 Menu Bar.  Displays the list of functions that can be performed on the HAVEN Management 
window. Each function (File, Options, Administration, Help) contains additional options. These 
options are displayed by using the mouse. 

• Button Bar.  Provides icons for quick access to commonly used menu items. 
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•	 Select/Add a Patient.  Enables the user to select a patient to access his/her assessment history. 
The list of patients is sorted by last name, but can be sorted by any of the column names by clicking 
on the column heading. 

• Previous 100.  Allows the user to display the previous 100 patients in the list. 

• Next 100.  Allows the user to display the next 100 patients in the list. 

•	 Archive Patient. Allows the user to archive a patient (and his/her assessments) to the default 
archive database. 

•	 Restore Patient.  Allows the user to restore a patient (and his/her assessments) from the default 
archive databases (only available in archive mode). 

• Add Patient.  Allows the user to add a patient. 

•	 Select/Add Assessment for Patient.  Allows the user to view the history of previous assessments 
and their status for the currently selected patient. For additional information on the status of 
assessments, see the Assessment Status Screen section. 

• Add Assmt.  Allows the user to add an assessment for a selected patient. 

•	 Correct Assmt.  Allows the user to correct an assessment (once it has been Locked [Exported]) for 
a selected patient. Only a System Administrator has access to this feature. 

•	 Delete Assmt.  Allows the user to delete the highlighted assessment for a selected patient. Only 
System Administrators have access to this feature. 

• Print Assmt.  Allows the user to print the highlighted assessment. 

• Enter Data.  Allows the user to enter data for the highlighted assessment for a selected patient. 

When the “Open Archive” option is selected, this option is set to “View Data” since the data is “View 
Only” by default in this mode. 

• View Only.  Allows the user to view an assessment for a selected patient in read-only mode. 

•	 HIPPS.  Allows the user to view the HIPPS category of reimbursement for an assessment. Users 
can view HIPPS categories for assessments with reason for assessment values of 01 - 05. 
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FILE MENU


From under the File menu, the user can access the following functions: Open Archive and Exit. 

Open Archive


This feature allows the user to switch between Archive Mode and Normal Mode. When selected, this menu 
choice will switch between checked (Archive Mode) and unchecked (Normal Mode). 

When in Archive Mode, the software points to the active archive database (as identified in the Archive Setup 
menu, described later). This feature allows the user to view the archived patients (and their assessments). 
In addition, the following features are available in Archive Mode. 

•	 Restore Patient. This function restores the patient (and patient assessment) data from the active 
archive database to the HHA.MDB database so the user can access the patient and perform all 
functions in Normal Mode. 

•	 Print Assessment. This function allows the assessment data entry form to be displayed in a format 
ready to print and save in various file formats. 

•	 View Data . This function allows the user to view the selected assessment in “View Only” mode 
using the data entry screens. If any changes need to be made, the patient should be restored. 

•	 View/Print Reports.  This function allows all of the standard reports to be produced using the 
archive database. 

•	 HIPPS. This function enables the user to view the HIPPS code for the currently selected 
assessment. 

These functions are the only ones available in Archive Mode, aside from the functions that allow the user to 
search for and select a patient and assessment. 
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Exit


This option allows the user to exit the HAVEN software. To exit HAVEN, select the Exit option from the FILE 
menu on the HAVEN Management Screen. 

The user can also exit HAVEN by selecting the ‘X’ (Close Window) in the upper right hand corner of the 
HAVEN Management Screen. 
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OPTIONS MENU


From under the Options menu, the user can access the following functions: Log Off/On, View/Print Reports, 
Import, and Export. 

Log Off/On


This option allows the user to return to the HAVEN Login screen. From here, the user can return to the 
HAVEN Management Screen or exit HAVEN. If the user returns to the Login screen, he/she can return to 
the HAVEN system by clicking on the “X” in the upper right corner of the screen. 

View/Print Reports


This feature is discussed in the Reports section. 

Import


This feature is discussed in the Import section. 

Export


This feature is discussed in the Export section. 

ADMINISTRATION MENU


From under the Administration menu, the user can access the following functions: Maintain Employee, 
Agency, and Patient Databases; Preferences; Archive Setup; Fix Inactive Fields; List Open Assessments; 
Reset Open Status; and Retrieve Patient with Hex Format. 

Maintain Employee, Agency, and Patient Databases


These maintenance functions are discussed in the System Setup section. 

Preferences


Preferences can be specified for assessment data entry and sequencing; the location of the primary HAVEN 
database (HHA.MDB); the default paths for use with import and export files; the operation of the HAVEN 
Backup function; and the desired number of assessments to be contained in a single archive file. 
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Assessments Tab


Under this tab, the user may specify whether to display radio buttons or check boxes for variables that allow 
only one choice (i.e., option pick one). The default display uses check boxes. Check boxes support easier 
keyboard data entry. Keyboard data entry allows tabbing across the set of options for a variable without 
forcing the user to select an option. Once an option is selected in the check box mode, HAVEN will still 
enforce the rule that ensures only one option from the list of items will be selected. 

Radio buttons automatically select the first item displayed in the list. Radio buttons also require the use of 
the tab and arrow keys to implement keyboard data entry. 

The user can also enable or disable strong enforcement of assessment sequencing under this tab. 
Assessment sequencing rules are enforced in two areas of the software: 1) adding assessments and 2) 
importing assessments. Strong enforcement prohibits the addition or import of assessments in an order that 
violates the sequencing rules. If strong enforcement is disabled, then assessments can be added or 
imported in an order that violates the sequencing rules. The user may also delete more than just the most 
recent assessment. 
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Paths Tab


This feature allows a System Administrator to enter the path where the HAVEN database HHA.MDB will be 
located. Note that the HAVEN application will shut down once a new path is entered. When HAVEN is 
restarted, it will look for HHA.MDB in the path specified. If the HHA.MDB cannot be found, HAVEN will 
alternatively look for HHA.MDB in the installation directory. If HAVEN finds HHA.MDB in the installation 
directory, it will reset the path value to the installation directory path. 

In addition, the System Administrator can specify where import files are located and where export files are 
created. 
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Backup Tab


By specifying a path for the Backup function in HAVEN, the data collection and archive databases in the 
HAVEN Data Entry System will automatically back up every time the system is exited normally. The path for 
the backup process cannot be the same as the path of the application or databases. For example, if HAVEN 
is installed to C:\HAVEN, the backup path cannot be C:\HAVEN. 

A complete explanation of the Backup function is available in the System Setup section. 

HAVEN System Reference Manual: September 1, 2003 HAVEN Data Entry � 25 



Archive Tab


The System Administrator can specify whether HAVEN will warn the user if the archive database exceeds 
the user-specified number of assessments. For example, if this option is checked and 1,000 is specified, 
then HAVEN will warn the user (prior to archiving a patient) if the currently active archive database contains 
1,000 or more assessments. 

It is strongly recommended that archive databases not be allowed to become too large in order to 
ensure best performance when opened in Archive Mode. 
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Archive Setup


One or more archive databases can be used to save archive patients and their assessments. From the 
Archive Information setup window, the user can create a new archive database, delete an archive database, 
and identify the active archive database. 

In versions of HAVEN prior to HAVEN 6.0, the archive database was saved with an extension of .ARK. 
In this version, when the program is first started up, all of the .ARK databases are changed to have an 
extension of .MDB. 

To create a new archive database, click on the <NEW> button. Enter up to an eight-character file name in 
the Database Name text box. The location (path) for the database must be entered. The user must also 
type in a description of the archive database by entering up to 25 characters in the Description text box. 
Users can click on the <SAVE> button to create the archive database or click on the <CANCEL> button to 
cancel the creation of the archive database. 

If several archive databases have been created, the user can specify a particular archive database by 
selecting it from the list. 

An archive database can only be deleted when it is empty (i.e., no records are contained in the database). 
When a selected database displays a record count of zero in the Select an archive database section, it can 
be deleted. A user might choose to delete an archive database if all of the records contained in it have been 
restored, if it was created in error, or if it was never utilized. 

To delete an archive database, select an empty archive database and click on the <DELETE> button. 
HAVEN will verify the deletion. Click on the <OK> button to return to the Archive Information screen. 

HAVEN System Reference Manual: September 1, 2003 HAVEN Data Entry � 27 



Only one archive database can be active at a time. To select the active archive database, highlight the 
databases you want to be active and select the “Make this database the active archive database” check box. 

Fix Inactive Fields


The Fix Inactive Fields feature allows a System Administrator to clear any data entry in inactive fields for a 
particular assessment. After highlighting an assessment, the System Administrator can select the Fix 
Inactive Fields option from the ADMINISTRATION menu. HAVEN will review the selected assessment and 
clear any variables that are inactive and should be empty. When the process is complete, HAVEN will verify 
whether or not any inactive fields were fixed. 

This option is only available for assessments that have a status of “New” or “In Use.” 

List Open Assessments


This feature allows users to view a list of assessments currently marked (*) as open. 

When using HAVEN across a network environment, only one user can access an assessment at a time. The 
List Open Assessments option displays the current user's ID, the patient's name and Social Security 
Number, and the assessment type for each assessment marked as open. 

To view the open assessments, click on the ADMINISTRATION menu and select the List Open Assessments 
option. The HAVEN Open Assessments screen will display the assessments currently open for data entry. 
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 An assessment is considered open while data entry is being performed. 

Reset Open Status


This feature allows a System Administrator to reset an assessment's Open status. The Open status is 
normally reset (the * disappears from the Open box) when a user exits data entry for an assessment. 

The Reset Open Status function is especially useful when abnormal termination of HAVEN (e.g., power 
failure, system lockup) occurs. When HAVEN is restarted, a user cannot access any assessments marked 
as Open. A System Administrator must reset these assessments before data entry can continue. 

To reset the Open status of an assessment, the System Administrator should highlight the assessment that 
needs to be reset, click on the AMINISTRATION menu, and select the Reset Open Status option. This 
action will clear the Open box and reset the currently selected assessment. If more than one assessment 
needs to be reset, highlight the next assessment and repeat the process until all of the desired assessments 
have been reset. 
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Retrieve Patient with Hex Format


The Retrieve Patient with Hex Format feature allows a System Administrator to retrieve patient information 
that has been masked. 

To search for a patient in hex format, click on the ADMINISTRATION menu, and select the Retrieve Patient 
with Hex Format option. System Administrators can search for patient information by entering the hex 
representation of the masked value in one or more of the following fields: the Patient ID Number, Patient 
Name, Medicare Number, Social Security Number, or Medicaid number. 

HELP MENU


From under the Help menu, the user can access the following options: General Help and About. 

Access General and About Help


General Help provides HAVEN system help regarding how to use and maintain the HAVEN software. 
About identifies HAVEN software and dictionary version information as well as application and data 
collection database (HHA.MDB) path locations. From the HAVEN Management Screen or any of the 
HAVEN Data Entry  screens, click on the HELP menu and select either the General Help or the About 
options. 

Context sensitive help is available from any window by pressing the <F1> key. Individual variable help 
is also available by right mouse clicking anywhere within a variable's frame on the data entry screens. 
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SELECT/ADD/ARCHIVE/RESTORE A PATIENT


The Select/Add a Patient section enables the user to search for and select the patient whose assessment 
history will be accessed. To re-sort the patient list, select the column heading you wish to sort on. Patients 
can be displayed in alphabetical or numeric order. Select the Last Name radio button to display patients in 
alphabetical order or select the SSN or ID radio buttons to sort numerically. Use the scroll bars on the 
Patient list box to view the available patients and click on the preferred row to select a patient. 

The user may search the Patient database by specifying the Last Name, Social Security Number (SSN), or 
ID of a patient in the Search for... text box. The user may then type in the first letter of the patient's last 
name or the first number of his/her Social Security Number or ID. The system will highlight the match for 
each set of characters as each new one is typed. 

To discontinue the search, clear the Search for... text box. The patients will then be displayed either 
alphabetically or numerically for selection within the Patient list box starting with the first patient in the 
selected order. Patients are displayed 100 at a time in the patient list. To view the next 100 patients in the 
list, select the <NEXT 100> button. The <PREVIOUS 100> button will display the previous 100 patients 
again. 

The purpose of the <ARCHIVE PATIENT> button is to help maintain the size of the system database 
HHA.MDB. The <ARCHIVE PATIENT> button allows a System Administrator to archive every patient whose 
assessments have a status of “Locked (Exported).” For instance, if a patient was discharged due to death, 
has no intention of returning, or a specified amount of time has passed since a patient's last transfer or 
discharge assessment, that patient and all his/her assessments can be archived for storage purpose to 
reduce the size of the system database (HHA.MDB). 

If HAVEN is in Archive Mode, the <ARCHIVE PATIENT> button becomes the <RESTORE PATIENT> 
button. The <RESTORE PATIENT> button enables the System Administrator to move a patient and his/her 
assessments back into the system database HHA.MDB; this function is useful if a patient unexpectedly 
returns to the agency. 

The <ADD PATIENT> button allows the user to add a new patient record. To edit/delete an existing patient 
record, the Maintain Patient Database option from the ADMINISTRATION menu item or the <MAINTAIN 
PATIENT DATABASE> button on the button bar must be selected. Refer to the Maintain Patient Database 
section for a detailed explanation of how to add/edit/delete a patient. 
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SELECT/ADD/EDIT/CORRECT/DELETE AN ASSESSMENT


The Assessment Selection section allows the user to view the history and status of previous assessments for 
the currently selected patient. Assessments are displayed in the order they were added, with the most 
recent assessment displayed first in the list. For each assessment, the effective date, assessment type, 
status, last user to access the assessment, and a correction number are displayed. Select an assessment 
by scrolling through the list and clicking on it. The user can access the selected assessment to perform data 
entry or edits by clicking on the <ENTER DATA> button. 

The Add Assessment section also enables the user to initiate a new assessment for the selected patient. 
Click on the <ADD ASSMT> button to access the HAVEN Reasons for Assessment screen (described 
below) before the assessment is added to the patient. 

Note the following: 

• Newly created assessments have a status of “New”; 
• Edited assessments have a status of “In Use”; 
• Completed Data Entry assessments have a status of “Locked (Exp Ready)”; and 
• Exported assessments have a status of “Locked (Exported)”. 

As of OASIS Version 1.30 (Reduced Burden), assessment types 02 and 10 no longer exist. However, 
these assessment types can be created using the 1.20 specification. Note that these assessments cannot 
be exported, since the OASIS State System will not accept any 02 or 10 assessments. 
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Reason for Assessment


When the user clicks on the <ADD ASSMT> button, the HAVEN Reasons for Assessment screen is 
displayed. 

If strong enforcement is disabled, the Reasons for Assessment will be displayed in green or red. Green 
indicates the user will be adding assessments in sequencing order. Red indicates the user will be adding 
assessments out of sequencing order. 

The response-specific instructions available for an assessment include: 

Start/Resumption of Care 

•	 Response 01.  Start of care—further visits planned - This is the start of care comprehensive 
assessment. A plan of care is being established, and further visits are planned. 

When 01, Start of Care, is selected, the M0030 Start of Care Date must be entered. The date will be 
tracked across assessments until a new start of care occurs. The user has the ability to change the date 
during data entry. 

•	 Response 02. Start of care—no further visits planned - This is the first visit; a comprehensive 
assessment has been performed. However, no additional visits will be made. Mark this response if the 
original order is for a one-time visit only. No additional data will be provided on this patient, as no plan of 
care is established (e.g., a subsequent discharge assessment is not expected). 
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 As of OASIS Version 1.30 (Reduced Burden), this reason type was removed. However, it is allowed 
using OASIS Version 1.20. Note that 02 assessments cannot be exported, however. 

•	 Response 03. Resumption of care (after inpatient stay) - The comprehensive assessment is being 
conducted when the patient resumes care following an inpatient stay of 24 hours or longer. 

When 03. Resumption of Care is selected, the M0032 Resumption of Care Date must be entered. This 
date will be tracked across the subsequent assessments until a new Start of Care or Resumption of Care 
assessment is added. 

Follow-Up 

•	 Response 04. Recertification (follow-up) reassessment - The comprehensive assessment is being 
conducted during the last five days of the certification period. 

•	 Response 05.  Other follow-up - The comprehensive assessment is conducted due to a significant 
change in patient condition at a time other than during the last five days of the certification period. 
This assessment is completed to update the patient's care plan. 

Transfer to an Inpatient Facility 

•	 Response 06.  Transferred to an inpatient facility—patient not discharged from agency - Data 
regarding the patient's transfer to an inpatient facility for 24 hours or longer (for reasons other than 
diagnostic tests) are reported. The patient is expected to resume care and is not discharged from 
the agency. When the patient resumes care, a Resumption of Care comprehensive assessment is 
conducted. Note the “skip pattern” included in the response. This response does not require a 
home visit; a telephone call may provide the information necessary to complete the required data 
items. 

•	 Response 07.  Transferred to an inpatient facility—patient discharged from agency - Data regarding 
the patient's transfer to an inpatient facility for 24 hours or longer (for reasons other than diagnostic 
tests) are reported. The patient is discharged from the agency. Note the “skip pattern” included in 
the response. This response does not require a home visit; a telephone call may provide the 
information necessary to complete the required data items. 

Discharge from Agency – Not to an Inpatient Facility 

•	 Response 08.  Death at home - Data regarding patient death other than death in an inpatient facility. 
A patient who dies before being admitted to an inpatient facility would have this response marked. 
Note the “skip pattern” included in the response. A home visit is not required to mark this response; 
a telephone call may provide the information necessary to complete the data items. 

•	 Response 09.  Discharge from agency - The comprehensive assessment is being conducted at the 
patient's discharge from the agency. This discharge is not occurring due to an inpatient facility 
admission or patient death. An actual patient interaction is required to complete this assessment. 
Note the “skip pattern” present in the response. 

•	 Response 10.  Discharge from agency—no visits completed after start/resumption of care 
assessment - This response is marked in the event of an unusual occurrence. The agency visits the 
patient at the start (or resumption) of care and establishes a plan of care. However, before another 
skilled visit is made, the patient is discharged. (For example, a family member may move the patient 
to another location.) This response is not marked at the same time as Response 2; this situation is 
very different. Note the “skip pattern” included in the response. This response should not be used if 
the patient is transferred to an inpatient facility or dies at home. 
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 As of OASIS Version 1.30 (Reduced Burden), this reason type was removed. However, it is allowed 
using OASIS Version 1.20. Note that a Reason 10 assessment cannot be exported. 

Select the OASIS Specification for the assessment being added. The default is the current OASIS 
specification. After a selection has been made (one response per assessment), click on the <OK> button to 
save the choice and return to the HAVEN Management Screen, or click on the <CANCEL> button to cancel 
the assessment and return to the HAVEN Management Screen. 

As of OASIS Version 1.30 (Reduced Burden), a number of changes were made to the assessment to 
“reduce the burden” of data entry. When the user selects Version 1.30 or higher, fewer data entry items are 
required for RFAs 4 and 5, a number of items are removed from all of the assessments, and two 
assessments (RFAs 2 and 10) are no longer valid. In addition, in Versions 1.30 or higher, a new tracking 
form makes it easier for repeating information to be duplicated on each successive assessment. 

Sequence of Assessments


In accordance with OASIS Data Specification 1.40, the sequence of assessments for a patient should 
conform to certain requirements. These requirements are described below: 

• After adding RFA (Reason for Assessment) 1, the user may add RFA 4, 5, 6, 7, 8, or 9; 

• After adding RFA 3, the user may add RFA 4, 5, 6, 7, 8, or 9; 

• After adding RFA 4, the user may add RFA 4, 5, 6, 7, 8, or 9; 

• After adding RFA 5, the user may add RFA 4, 5, 6, 7, 8, or 9; 

• After adding RFA 6, the user may add RFA 1, 3, 4, 5, 7, 8, or 9; 

• After adding RFA 7, the user may add RFA 1, 3, 4, 5, 6, 8, or 9; 

• After adding RFA 8, the user cannot add any RFA record; and 

• After adding RFA 9, the user may add RFA 1. 

For more information on sequencing enforcement, see the Preferences section. 
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Effective Date of Assessment


After an assessment is added, the Effective Date for the assessment will be blank. Following is a list of the 
assessments and the date variables that need to be completed in data entry before the Effective Date will be 
displayed on the HAVEN Management Screen. 

• Start of care—further visits planned M0030_START_CARE_DT (Start of care date); 

• Start of care—no further visits planned M0030_START_CARE_DT (Start of care date)*; 

• Resumption of care (after inpatient stay) M0032_ROC_DATE (Resumption of care date); 

•	 Recertification (follow-up) reassessment M0090_INFO_COMPLETED_DT (Date assessment 
completed); 

• Other follow-up M0090_INFO_COMPLETED_DT (Date assessment completed); 

•	 Transferred to an inpatient facility—patient not discharged from agency M0906_DC_TRAN_DTH_DT 
(Discharge/transfer/death date); 

•	 Transferred to an inpatient facility—patient discharged from agency M0906_DC_TRAN_DTH_DT 
(Discharge/transfer/death date); 

• Death at home M0906_DC_TRAN_DTH_DT (Discharge/transfer/death date); 

• Discharge from agency M0906_DC_TRAN_DTH_DT (Discharge/transfer/death date); and 

•	 Discharge from agency—no visits completed after start/resumption of care assessment 
M0906_DC_TRAN_DTH_DT (Discharge/transfer/death date)*. 

*Although these types of assessments can no longer be created or exported, it is still possible to 
complete data entry for these assessments. 

The date displayed with each assessment on the HAVEN Management Screen will not be visible until 
the effective date is determined. 
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Correct an Assessment


Once an assessment has been Locked (Exported), only a System Administrator has access to it. Listed 
below are the three supported types of corrections: 

•	 Assessment was submitted to the State and was rejected.  By selecting this option, the 
assessment lock dates are cleared and the user is taken directly into data entry for that assessment. 
After the necessary corrections are made, the assessment can be completed, locked, exported, and 
re-submitted to the State. 

•	 Assessment was submitted to the State and was accepted. Correction to non-key fields only 
is necessary.  To correct an assessment with non-key field errors in the assessment, a copy of the 
assessment is made and the correction number is incremented by one. After the corrections are 
made, the assessment can be exported. (This type of correction is no longer valid. Use inactivation 
of the assessment instead.) 

•	 Assessment was submitted to the State and was accepted. Correction to non-key fields is 
necessary.  To correct an assessment with non-key field errors in the assessment, a copy of the 
assessment is made and the correction number is incremented by one. After the corrections are 
made, the assessment can be exported. 

•	 Assessment was submitted to the State and was accepted. Inactivation of the assessment is 
necessary.  By selecting this option, a copy of the assessment record is created. The user is taken 
directly into data entry for that assessment, however the entire assessment is view-only. After 
viewing the assessment, the user can exit the assessment. The correction number on the HAVEN 
Management screen and the assessment status will be “Locked (Exp Ready).” 

After exporting an inactivation record, a new assessment containing the data from the inactivated 
assessment can be created. Select the inactivation record from the HAVEN Management screen and click 
on the <CORRECT ASSESSMENT> button. The HAVEN Data Entry System pop-up box will appear. Click 
on the <OK> button to create the assessment pre-populated with the data from the inactivation record. The 
correction number for this assessment will be 00. 

If corrections are completed for a submitted assessment from a prior version of HAVEN, the prior version will 
be used for an error check. 
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For further information on OASIS correction procedures, see the OASIS Data Submission Specifications  link 
available from CMS at http://www.cms.hhs.gov/oasis. 

Delete an Assessment


Only a System Administrator may delete an assessment. To delete an assessment, select the assessment 
and click on the <DELETE ASSMT> button. The System Administrator will receive two messages asking for 
verification before the assessment will be deleted from the database. Note that once an assessment is 
deleted from the database, it cannot be recovered. 

Because of the sequencing requirements, assessments may be deleted from the top down only. Start 
with the first number in the Select/Add an Assessment for Patient text box and delete the necessary 
assessment records. As records are deleted, the assessments are automatically renumbered. If strong 
enforcement is disabled, this restriction does not apply and the user may delete any assessment. 
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Print an Assessment


Select the <PRINT ASSMT> button to print the currently selected assessment. Once selected, the user can 
choose to display either a subset or all of the OASIS data entry sections. Selecting the <CANCEL> button 
will stop the print process. When the assessment report is completed, it will appear in the Report View 
window. From the window the user has the option to print the report as well as to save it in .PDF (Adobe 
Acrobat), .RTF (Rich Text Format), or .TXT (Text) format. 
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View Only


If the View Only option is checked, the user is allowed to view an assessment in read-only mode. This 
option is useful for reviewing the data entered and ensuring that no data are accidentally edited. 

EXIT


The user may exit the HAVEN software by clicking on the <EXIT>  button or by selecting the FILE menu item 
and clicking on the Exit option. 
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HAVEN DATA ENTRY WINDOW


The Data Entry screen typically consists of the following components: 

• Title Bar.  Displays the HAVEN Data Entry function and the assessment type. 

•	 Menu Bar.  Displays the list of functions that can be performed on the Data Entry window (File, 
HIPPS, Options, Edit, Help). Each of these functions contains additional options that can be 
displayed by using the mouse. 

•	 Data Entry Button Bar.  Provides the various Data Entry functions. Currently, three functions/icons 
are available: Stop Data Entry, Pause Data Entry  (pause abstraction time for data entry), and 
Enter Notes (for an assessment). 

•	 Data Entry Top.  Displays the Last Name, First Name, Middle Initial, and Social Security Number 
(SSN) of the selected patient at the top of the Data Entry window. 

•	 Tabs/Subtabs.  Displays the names of the selected screens. Each tab can have up to five subtabs 
associated with it. When a tab or subtab is selected, the Data Entry window of the selected screen 
or subscreen will open in the space below it. Users can switch between tabs and subtabs by using 
the <PAGE UP> and <PAGE DOWN> keys. 
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•	 Data Entry Window.  Contains variables that belong to the selected screen or subscreen. On this 
screen, data entry can be performed for each variable. 

ENTER DATA FOR A VARIABLE


Perform data entry after selecting a Patient record and an Assessment form. (See previous sections: 
Select/Add a Patient and Select/Add/Edit/Correct/Delete an Assessment.) Data entry can be exited at any 
time by clicking on the File menu item and selecting the Stop Data Entry (Validate and Exit Assessment) 
option. 

The most efficient way to move around the data entry system is to use the mouse. Since Microsoft has 
restrictions pertaining to variables with radio buttons, the mouse must be used to move between variables of 
this type (Option (Pick One)). However, tabbing is also available to move around in the data entry system 
from the Preferences menu by choosing check boxes instead of radio buttons for variable type Option (Pick 
One). 

The Preferences menu is only available to users with System Administrator rights. This option can be 
requested from the System Administrator. 

To begin data entry, point to the preferred tab or subtab and click on it to open that screen. Follow the 
descriptions below to enter data for the various variable types. 

Option (Pick One)


The variable type Option (Pick One) includes the items from which only one item can be chosen. Choose 
an item by selecting the radio button or check box (if the Check Boxes option has been selected from the 
Preferences menu) next to the item. Users may clear radio buttons by clicking on the <RIGHT MOUSE> 
button and selecting the Clear Variable option. 
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Option (Pick One or More)


The variable type Option (Pick One or More) includes options from which one or more items can be 
chosen. Choose the item(s) by marking the check box next to the desired item. Note that, normally, the last 
item on the list (usually None of the Above) clears all the other items. 

Check boxes have two possible states: checked and unchecked. Checked indicates that the option is 
true. Unchecked indicates that the option is false or not applicable. 

Date


The variable type Date accepts data entered in the date format that has been specified in the design (the 
default format for date is MM/DD/YYYY). If a complete date is not available for [M0066] Birth Date, the user 
can enter a partial date in the form of “ / /YYYY” or “MM/ /YYYY.” 

If a complete or partial date is not available for variable [M0066] Birth Date, the user can enter 
<SHIFT> + ? as the UTD (unable to determine) option. A dash will be displayed. This function is available 
only for the [M0066] Birth Date variable. 
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String


The variable type String accepts text entered in any alphanumeric combination. The string is limited in 
length by variable type. 

ICD-9


The ICD-9 variable type allows the user to either type the Primary Diagnosis code directly into the ICD-9 
variable box or click on the ICD-9 Dx button, which displays the ICD-9 Diagnosis Codes window. In this 
window, the user can search for a code by typing the code into the Search on Code text box (the codes will 
be displayed automatically) or by typing a description into the Search by Description text box. As entries are 
made into either search box, the list of ICD-9 codes/description matching the pattern entered will appear in 
the list below. To select an ICD-9, the user can check (highlight) the code of interest and select the <OK> 
button, or simply double-click the desired code. 

HAVEN System Reference Manual: September 1, 2003 HAVEN Data Entry � 44 



SPECIAL FEATURES (HAVEN DATA ENTRY SCREEN)


Enter Notes


To enter a general note about a variable during data entry, select the <ENTER NOTES> icon. The displayed 
pop-up box allows the user to enter a note containing up to 32,000 alphanumeric characters. Since all of the 
notes for a given assessment are stored in one file, copying the Variable Screen Title (e.g., [M0072] Primary 
Referring Physician ID) before writing a note provides a good reference point to the variable. To paste the 
screen title of the current variable into the note, select the <COPY> button. Click on the <CLOSE> button to 
save the notes and return to the Data Entry window. 

Pause Button


When the user selects the <PAUSE DATA ENTRY> icon, the internal HAVEN clock that keeps track of the 
amount of time spent on an assessment stops. This feature is useful for agencies that want to keep track of 
abstraction time for performance reasons but do not want the breaks in data entry to be counted. 

Abstraction time does not accumulate in View Only mode. 

Clear Value on a Variable Radio Button


To clear variables with radio buttons, click on the <RIGHT MOUSE> button and select the Clear Variable 
option. 
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View Help


To display the Help available for each variable, click on the <RIGHT MOUSE> button and select the View 
Help option. For variables that do not have any other associated options (e.g., the Clear Variable option), 
the Help option will be displayed immediately. 

Print Screen


Selecting the Print Screen option from the File menu item allows the user to print the current screen. If the 
screen does not print properly (possibly due to the default printer settings), another process, screen 
capturing, is available. 

There are several steps to follow when capturing a screen in design or data entry for printing. To copy a 
screen, press on the <PRINT SCRN> button or press the <ALT> + <PRINT SCRN> buttons to capture only 
the active window. After opening a word processing package such as Word or a graphics package such as 
Paint, paste the screen into the document by pressing on the <CTRL> + <V> buttons. The screen can also 
be copied into a document by using the paste function available in the application being used. 

ICD-9 Lookup


During data entry, an on-line resource for viewing the ICD-9 diagnosis codes (and descriptions) is available. 
Selecting the ICD-9 Lookup option from the Options menu item provides the user with the HAVEN ICD-9 
Code Lookup screen. The user can search for a code by typing a code into the Search by Code text box 
(the codes will be displayed automatically) or by typing a description into the Search by Description text box 
and then clicking on the <GO> button. Click on the <CLOSE> button to return to data entry. 

Edit Agency Data


During data entry, the user has access to the HAVEN Agency Information screen from the Edit menu 
items. This feature allows the user to edit the Agency Information for an assessment. For example, if 
incorrect information is added during the setup process for the agency, the user can edit this information 
during the data entry process. Note that changes to the Branch State (M0014) and Branch ID (M0016) will 
not be reflected in the current assessment. However, these variables are enabled in data entry and can be 
changed using that method. 

Edit Patient Data


During data entry, the user has access to the HAVEN Patient Information screen from the Edit menu items. 
This feature allows the user to edit the Patient Information for an assessment. For example, if incorrect 
information is added during the setup process for the Patient database, the user can edit this information 
during the data entry process. 

After saving the edited information, HAVEN will ask the user whether all unexported assessments (except for 
non-key field correction assessments) should be updated. It is recommended that this process be completed 
to maintain consistent patient information across assessments in export files. The user may choose not to 
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update any unexported assessments (except for non-key field correction assessments) and HAVEN will still 
update the current assessment. 

This menu item is not available during data entry for non-key field correction assessments, since 
changes to patient information would result in non-key changes. 

When editing the HAVEN Patient Information screen during data entry, only the Patient Information 
portion of the screen will be visible. The user cannot search for or select another patient. 
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CALCULATE/VIEW HIPPS (IF APPLICABLE)


HIPPS calculations are automatically performed for an assessment when the data entry for the assessment 
has been completed and its status is made “Locked (Exp Ready).” HIPPS can be calculated for 
assessments with RFAs 1-5. The HIPPS can be recalculated at any time during data entry. Click on the 
HIPPS menu item in data entry to recalculate the HIPPS. The View HIPPS screen will be displayed. Note, 
however, that the HIPPS values are not saved until the assessment is locked. 

HIPPS can also be viewed from the HAVEN Management Screen using the <HIPPS> button. If the 
assessment status is “Locked (Exported),” the HIPPS have already been calculated and will merely be 
displayed in the View HIPPS screen; otherwise, the HIPPS will be recalculated and then displayed. 

ASSESSMENT VALIDATION AFTER EXIT


When the user attempts to exit data entry, the system will check all of the rules in place. All rules must be 
satisfied before an assessment can be marked as complete. One such rule is the mandatory rule. All 
mandatory variables must have valid data values. If a mandatory variable is left blank (data not entered), the 
user will be warned that the variable is mandatory (e.g., ERROR: Is Blank But Should Not Be: 
(M0030_START_ CARE_DT. Start of Care Date)). The user will not be able to mark an assessment as 
complete until all mandatory variables have been entered. 

For easy access, variable validation messages also contain the name of the screen on which a 
variable is located. 

In addition, any assessment validation warnings will be displayed. Since these warnings are not errors (and 
are merely for informational purposes), they do not have to be resolved before an assessment can be 
marked as complete. 

Messages marked as “FATAL” are errors not addressable by data entry personnel. These errors 
should be referred to the System Administrator. 
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Three options are available on the Assessment Validation Warnings screen. Clicking on the <PRINT 
WARNINGS> button will print the first 30 errors/warnings listed on the screen. Selecting the <CONTINUE> 
button will take the user to the Assessment Status screen where the assessment can be exited by marking 
it complete or in use. Choosing the <RETURN TO DATA ENTRY> button will allow the user to continue the 
data entry process. 
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ASSESSMENT STATUS WINDOW


On the Assessment Status screen, the status of an assessment must be marked before the assessment 
can be exited. 

Listed below are the various options available when exiting the Assessment Status screen: 

• Assessment in Active Use—An assessment has been edited; 

• Completed Data Entry—Data entry has been completed for an assessment; 

• New—A newly created assessment; 

• Locked (Exported)—An exported assessment; and 

• Locked (Exp Ready)—An assessment with a status of closed (data entry completed). 

At a minimum, the user will be required to mark the assessment as “Assessment in Active Use” or 
“Completed Data Entry.” These are the default options on the Assessment Status screen. 

In addition, the other options available on the Assessment Status screen (New, Locked (Exported), Locked 
(Exp Ready)) will automatically be selected depending on the type and status of the Assessment. 

To mark the status, select the best choice and press the <EXIT ASSESSMENT> button. 

Once an assessment has been marked “Locked (Exported),” only users with System Administrator 
rights can reopen to make corrections. 
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OASIS PATIENT TRACKING DATA


As of OASIS Version 1.30 (Reduced Burden), a new patient tracking form was used for each assessment. 
The intention of the tracking form is to keep track of key information that does not change frequently between 
assessments, such as the patient’s race/ethnicity. Many of these patient items were being tracked across 
assessments by HAVEN. However the following items were added in HAVEN Version 6.0 and are now 
tracked: 

• M0030 (Start of Care Date); 
• M0032 (Resumption of Care Date or Not Applicable); 
• M0072 (Primary Referring Physician ID or Unknown or Not Available); 
• M0140 (Race/Ethnicity); and 
• M0150 (Current Payment sources). 

These variables are tracked for each patient from the most recent assessment. For example, if the user 
updates M0140 on the current assessment, the values become the default M0140 values tracked for the 
patient (if the user chooses). The one exception is M0150; if this variable is changed, HAVEN asks the user 
if the patient database should be updated. It is expected that M0150 values can change within an episode of 
care. 

To ensure that data can be entered out of sequence, the user is given the option to not update the patient 
tracked variable upon exiting data entry. This exit is performed with warning messages. Under normal data 
entry circumstances, the warning messages will not appear. 

For users upgrading to Version 6.0 or higher, the tracking items will be embedded in each existing 
assessment but will not yet be tracked for the patient. Each time an assessment is opened for an existing 
patient, the tracking variables will be copied into the patient database where the items are blank at the 
patient level. 

If the most current tracked item value is already saved, the user is warned for confirmation purposes only 
when the user changes it. 

Finally, the tracked variables are copied into each assessment (as applicable) as the assessment is created. 

The process is designed to make it easier to track variables across assessments and only require a change 
when necessary. 
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HAVEN DATA EXPORT


CREATE DIRECTORIES/FOLDERS FOR EXPORT


It is strongly recommended that a separate directory from the installation directory be created for export files. 
The following instructions will enable a user to create a new directory/folder using Windows Explorer. To 
access Windows Explorer, click on the <START> button in the lower left corner of the screen, select the 
Programs option, and then select the Windows Explorer option. 

After selecting the Windows Explorer option, the following screen will appear. 

To add a new directory/folder to an available drive such as C:, click once on (C:) in the left window. Next, 
click on the File menu, select the New option, and then select the Folder option. After selecting the Folder 
option, a highlighted New Folder will be displayed at the bottom of the Name list in the right window. 
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With the NEW FOLDER highlighted, left mouse click inside the highlighted frame and type in a name for the 
directory/folder. Whatever is typed within the frame replaces the words “New Folder.” After typing a name, 
press the <ENTER> key on the keyboard or left mouse click anywhere outside of the frame. 

To add a subdirectory/folder to an existing directory/folder (e.g., add a subdirectory named Export to 
HAVEN), click on (C:) in the left window and select the newly created folder (i.e., HAVEN) displayed under 
the Name list in the right window. Next, click on the new folder (the right side of the screen should go blank) 
and repeat the instructions for adding a directory/folder. 

Exit Windows Explorer by clicking on the “X” in the upper right corner of the screen or select the Close option 
from the FILE menu. 

EXPORT/LOCK ELECTRONIC FORMS


To initiate the Export function, select either the Export option from the Options menu item or the <EXPORT> 
button on the HAVEN Management Screen. 

The HAVEN Export function enables users to export data for “Export Ready” assessments from the HAVEN 
database into the Data Record Layout format (i.e., 1,448-byte string). This format is suitable for submission 
to the state. Note that each data field in each exported assessment has been error-checked in accordance 
with the rules specified in the HAVEN Data Record Layout. 
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Identifying information is masked for private pay assessments using the SHA-1 hashing algorithm. The fields 
with identifying information include: the patient's first and last names, patient ID, Social Security Number, and 
Medicaid and Medicare numbers. Identifying information is masked at export time and written to the export 
file. During the export process, embedded and trailing blanks are masked. An embedded blank is the space 
between two words or two characters. A trailing blank is the space at the end of a word or a string of 
numeric characters. 

For example, the default number of characters allowed in the first name field is 12. If a patient's first name is 
less than 12 characters long, the system will include embedded and trailing blanks during export to meet the 
default requirement of 12 characters. For instance, the name Mary Beth has nine characters, including one 
embedded blank. During export, the entire string of nine characters plus three trailing blanks after Beth (a 
total of 12 characters) will be masked. 

For Specification Version 1.04 assessments: The rules for determining private pay status are as 
follows. If the Reason for Assessment is 01, 02, 03, 04, 05, or 09 the private pay status will be determined 
by looking at M0150 field. If one of the following options: 1 - Medicare (traditional fee-for-service), 2 -
Medicare (HMO/managed care), 3 - Medicaid (traditional fee-for-service), or 4 - Medicaid (HMO/managed 
care) is selected for the M0150 field, then the assessment is not considered private pay and will not be 
masked during export. If none of the options 1-4 are selected, then the assessment is considered private 
pay and will be masked during export. 

The M0150 field is not included in Reason for Assessments 06, 07, 08, or 10. If the user selects 06, 07, 08, 
or 10 as the Reason for Assessment, the private pay status is based on the last assessment with a 
completed M0150 field. If no previous assessment with a completed M0150 field exists, the system default 
is to not mask the patient's information. If 06, 07, 08, or 10 are selected as the Reason for Assessment, the 
user has the option to override the masking decision after the private pay status has been determined. 

Following is a description of the Export function. 

•	 Select the type of submission—New Export or Previous Export. Resubmissions are described in the 
next section. 

•	 Enter a description of the file into the Export Description text box. (Optional—if left blank, the 
number of assessments exported will automatically be stored in the description). 

•	 Enter the path/file name into the Export Path and File Name (including extension) text box. Either 
type the information in the text box or click on the <FILE FOLDER> icon and select a path and enter 
a file name. The data will be saved in text file format. The user may want the file name to 
correspond to the description used in the Export Description text box. 

•	 The assessments will be displayed in the Select Assessments to be Included in Export  text box. To 
select one assessment to export, highlight the desired assessment. To select more than one 
assessment to export, use the <SHIFT> or <CTRL> keys. To include all of the displayed 
assessments for export, click on the <SELECT ALL> radio button. To cancel the current selections, 
click the <CLEAR ALL> radio button. 

EXAMPLE: 

For easy reference, the user may wish to create a directory called EXPORT with subdirectories for 
the year/month. This structure will help to organize the export files for submission to the State. The 
saved file names could reference the weeks of the month (e.g., 
C:\EXPORT\1998\AUGUST\WEEK1.TXT). It is important to remember to include the file extension 
.TXT. Review the “Create a Directory/Folder” section below for complete instructions on creating a 
directory/folder. 
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•	 Select the type of submission—Production, Test, or Local Use. For Production submissions, an 
assessment always receives the status “Locked (Exported)” once it has been exported. The export 
header record contains a field called the Test/Production Indicator that identifies the type of 
submission. 

On export, if either production or test submission is selected, any private pay assessments will be 
masked and the M0160 field will be blanked out in the export file. If local use is selected, no masking is done 
and the M0160 field is not blanked out. The submission type Local Use should be used whenever 
transmission within an agency is required. 

For additional security, a Local Use file may be encrypted by checking the <Encrypt file> checkbox and 
entering a 16-byte encryption key. The key can contain any combination of letters or numbers. It is 
extremely important for the user to make a note of the key value. An encrypted Local Use file may only be 
decrypted by using the HAVEN Import function, checking the <Decrypt local use file> checkbox, and entering 
the aforementioned 16-byte encryption key. 

Click on the <EXPORT> button to complete the export process. A message will be displayed stating that the 
export is complete and the file is ready to submit to the state. Click on the <OK> button to close the 
message box. After the export is completed, the current date, file and path name, and the description of the 
exported file will be displayed in the Previous Exports text box. Click on the <CLOSE> button to exit the 
Export function and return to the HAVEN Management window. 
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RE-EXPORT LOCKED ELECTRONIC FORMS


Users have the ability to re-submit previously exported (i.e., locked) assessments should an error be 
detected by the State System. To re-submit records, users select the Resubmission radio button and are 
presented with a list of previous submissions in the Previous Exports list box. After selecting a previous 
submission, the user may then generate a new export file that contains data for each of the assessments 
displayed in the Select Assessments to be Included in Export  list box. 
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HAVEN DATA IMPORT


PERFORM ERROR CHECK ON AN IMPORT FILE


The System Administrator has the capability to import files. Import files must utilize the same format as 
export files (i.e., they must contain a header record, assessments in the 1,448-byte string format specified in 
the HAVEN Data Record Layout, and a trailer record). In addition, only files created with the export 
submission type of ‘Local Use’ may be imported. These files contain a value of '2' for the test and production 
indicator at position 574 in the header record. On the HAVEN Management Screen, the user may click on 
the <IMPORT> button or select the Import function from the Options menu item. 

After selecting the Import function, the HAVEN Import  pop-up box will be displayed. The user must enter a 
file path/name for the fi le to be imported. If the file to be imported is an encrypted Local Use file, the 
<Decrypt local use file> checkbox must be checked and the corresponding 16-byte key must be entered. 

The user may check the file for errors by clicking on the <ERROR CHECK FILE> button. Each record in the 
import file is processed in accordance with the rules specified in the HAVEN Data Record Layout. When the 
error checking is complete, a message box will appear, giving counts of the records checked and errors 
found. 

Any errors or warning messages will be displayed in the Report View window. From here, the errors can be 
printed or saved in .PDF (Adobe Acrobat), .RTF (Rich Text Format), or .TXT (Text) format. 
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IMPORT HAVEN DATA


The user may proceed with the import by clicking on the <IMPORT> button. This action will process all 
records in the designated import file. After the import has been completed, a message box will appear 
stating that the import is complete and displaying the number of assessments that were imported. 

If any errors or warning messages were associated with the import file, the errors will be displayed in the 
Report View window. From here the errors can be printed or saved in .PDF (Adobe Acrobat), .RTF (Rich 
Text Format), or .TXT (Text) format. 

AGENCY DATA


The Agency information in the header record is compared with the existing information in the agency 
database. If the information does not match, the user is given the option to abort the import. This action is 
useful if a wrong file is being imported. It is recommended that assessments from different agencies not be 
mixed together in order to maintain the integrity of the export files. 

If the user continues with the import, he/she will be given the option to update the agency database. If 
changes are made to any of the three agency fields (i.e., Agency State Assigned Unique ID, Agency 
Medicare Provider Number [M0010]; and Agency Medicaid Provider Number [M0012]) or copied from the 
agency database into the assessment records, HAVEN will ask the user whether all unexported 
assessments should be updated. It is recommended that this update be completed to maintain the integrity 
of the export files. 
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If an imported assessment contains new or updated agency or patient information, but the mandatory agency 
or patient fields are incomplete, then the assessment will not be imported. The user will be notified that the 
agency or patient information was not added or modified and the assessment was not accepted. New or 
updated information will also be rejected if it does not satisfy the consistency rules. 

PATIENT DATA


The Patient information for each assessment in the import file is matched against the data in the existing 
patient database. The software compares the following fields: 

• First Name, Last Name, Date of Birth, Gender; 

• Social Security Number; 

• Medicare Number; 

• Medicaid Number; 

• Patient ID Number; and 

• State Provided Patient ID. 

If a match is not found, a new entry will be added to the patient database. For each assessment, HAVEN will 
display how the patient was matched. The user can override this by checking the box “Do not display patient 
match information during import.” 

By default, a message will be displayed when a new patient is added; however, the user can override this 
feature by checking the box labeled “Do not give warning message when new patient is added during 
import.” This override is useful when importing assessments for a large number of patients who do not have 
previous patient database information in HAVEN. 

The patient information in the imported file is compared with the existing information in the patient database. 
If the information does not match, by default, the user is given the option to update the patient information in 
the patient database and the unexported assessments. However, the user can override this feature by 
checking the box labeled “Do not give warning message before updating patient information during import.” 
This override is useful when importing a large number of assessments that have non-static patient 
information. 

ASSESSMENT DATA


Imported assessments may have a status of “In Use,” “ Locked (Exp Ready),” or “Locked (Exported).” 

For an imported assessment to be “Locked (Exp Ready)” or “Locked (Exported),” the assessment must pass 
all error checking. By default, assessments with no errors are assigned “Locked (Exp Ready)” status. 
However, if the “Assign Exported status to assessments without errors” checkbox is checked, then the 
assessments will be assigned “Locked (Exported)” status. If the Lock Date is missing or invalid, the system 
will assign a Lock Date of the current date. 

All other assessments will be assigned the “In Use” status. 
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Duplicate assessments are identified during the import process and are not added to the HAVEN database. 
The following fields are used to identify duplicate assessments: 

• Agency State Assigned Unique ID; 

• Patient Information; 

• M0100_ASSMT_REASON; 

• M0030_START_CARE_DT; 

• Effective Date; and 

• Correction Number. 

Assessment sequencing rules are enforced in three areas of the software: 1) adding assessments, 2) 
correcting assessments, and 3) importing assessments. Strong enforcement prohibits the import of 
assessments in an order that violates the sequencing rules. If strong enforcement is disabled, then an 
assessment can be imported in an order that violates the sequencing rules. Note that a modification or 
inactivation record can only be successfully imported if the assessment to be modified or inactivated already 
exists in the HAVEN database. 

If an ASCII file is created in a software package other than HAVEN, some variables, which should be empty, 
may contain data and therefore the assessment cannot be completed. However, when a user tries to access 
one of these variables inside HAVEN to clear its value, the variable cannot be cleared, because it is 
disabled. The Fix Inactive Fields feature discussed in the HAVEN Data Entry section can be used to clear 
these values. 
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REPORTS


SELECT A REPORT TO VIEW/PRINT


HAVEN provides the user with the following report options: 

• A report to view the data entry for one or more assessments (Assessment Data Entry Report); 

• A report to view all assessments with “In Use” status (All Assessments In Use); and 

•	 A report to view masked values in Hex format for fields subject to protection (Masked Values in Hex 
Format). 

When the View/Print Reports function is selected, the user will be presented with a HAVEN Reports 
window where the report of interest can be selected. 

After selecting the report, click on the <OK> button to begin generating the report or, if applicable, go to the 
report specific selection criteria associated with the selected report. 
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ASSESSMENT DATA ENTRY REPORT


For quality control/review purposes, this report displays the data entered for an assessment(s). 

To report on an assessment(s), the user can: 

• Search for an assessment by Patient, Locked (Exp Ready), In Use, or Locked (Exported). 

•	 Patient.  Follow the instructions discussed in the HAVEN Data Entry section under Select/Add a 
Patient. 

•	 Locked (Exp Ready).  A list of assessments coded “Locked (Exp Ready)” will be displayed in the 
Select Assessment(s) to Report list box from which the user can choose. 

•	 In Use . A list of assessments coded “In Use” will be displayed in the Select Assessment(s) to 
Report list box from which the user can choose. 

•	 Locked (Exported).  A list of assessments coded “Locked (Exported)” will be displayed in the Select 
Assessment(s) to Report list box from which the user can choose. 

•	 After making a selection, click on the <OK> button to produce the report(s) or the <CANCEL> button 
to return to the HAVEN Reports screen. To exit Reports, click on the <CANCEL> button. 
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 A report(s) can take some time to produce depending on the size of the database. Also, if a large 
number of assessments exist in the system, it is not advisable to select all of the assessments at once 
because of the amount of time it takes to produce the reports. 

When the report has been produced, it will be displayed in the Report View window. From there, the report 
can be printed or saved in .PDF (Adobe Acrobat), .RTF (Rich Text Format), or .TXT (Text) format. 

ALL ASSESSMENTS IN USE


This report lists all assessments with an “In Use” status. 

Included in the report for each assessment is the Patient ID, Last Name, First Name, Medicare Number, 
Social Security Number, Medicaid Number, Reason for Assessment, Effective Date, and the Last User to 
access the assessment. 

From the Report View window, the user can print or save the report in .PDF (Adobe Acrobat), .RTF (Rich 
Text Format), or .TXT (Text) format. 
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MASKED VALUES IN HEX FORMAT


When an assessment is masked, the masked values are written to a separate table. This report lists the 
masked values in hex format along with the original unmasked values. Assessments only contain masked 
values after they have been exported. 

From the Report View window the user can print or save the report in .PDF (Adobe Acrobat), .RTF (Rich 
Text Format), or .TXT (Text) format. 
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APPENDIX A


REPAIR/COMPACT UTILITY FOR MICROSOFT 
ACCESS DATABASE 

This utility module is named REPAIR.EXE. Use standard Windows procedures to execute this utility. 

IMPORTANT: It is strongly recommended that the databases be backed up and 
archived before the Repair/Compact utility begins. Not all damaged Access 
databases can be repaired and compacted by this or any repair/compact utility. 
If a database is badly corrupted, data truncation may occur as the result of a 
repair and compact and data loss may result. 

IMPORTANT: This function only works on a valid Microsoft Access 2.0 or 97 
database with an .”MDB” or .”ARK” extension. 

The Microsoft Access Databases Repair Utility is designed to fix a Microsoft Access database that becomes 
corrupted. To use the Repair/Compact utility, select the file using the drive, directory, and file list boxes on 
the single window that comprises this utility. The name of the selected file appears in the lower left portion of 
the window. 

The Repair/Compact function of the Repair/Compact utility tries to repair any index corruption attempts to 
recover from data loss, and compacts records on the selected database to recover space when records are 
deleted. Since the size of the database files does not decrease when records are deleted from the 
database, it is recommended that this program function be used when a large number of records are deleted 
from the database. 
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To begin the compacting process, click on the <REPAIR AND COMPACT> button. The user will be 
prompted for a new database name to which the new data will be repaired and compacted. Enter the 
database name and click on the <OK> button to complete the repair and compact function. If successful, the 
message “Repair and compact completed!” is displayed; otherwise, an error message is displayed. 

The amount of time it takes to repair and compact depends on the size of the database and the speed of the 
computer. To cancel the Repair/Compact function, click on the <CANCEL> button. 

IMPORTANT: Do not interrupt the repairing and compacting process. An 
interruption may leave the database in an unstable state and could result in data 
loss. 

After repairing, compacting, and verifying that the records have been repaired 
and compacted properly, it is important that the user replace the working 
database with the repaired and compacted one since the replacement is not 
performed automatically. 

To exit the Repair/Compact utility, click on the <EXIT> button. 
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GLOSSARY OF TERMS


Data Entry


A MedQuest function that allows users to collect data for the data entry system designed by the 
MedQuest Design function by creating the data store file called XXX.MDB, where “XXX” represents the 
module acronym (e.g., HHA.MDB is the data store file for the data entry module HAVEN). 

Data Entry Rule


A rule specified during the design process that is executed during data entry. 

Data Entry System


A system designed by MedQuest to collect clinical data for a data analysis project. Each project is called 
a Module and is represented by a three-character acronym (e.g., HHA is the Data Entry System for the 
OASIS Home Assessment Validation and Entry (HAVEN) System project). 

Edit


The process by which data is modified. This term can also be used to reference features performed on 
data to ensure the correctness and integrity of the modified data. 

Module


See Data Entry System. 

Screen


A screen is an area beneath the tab where variables are presented. A tab represents a screen. The 
variables on the screen are displayed by selecting a tab. A tab may contain one or more subtabs. 

HAVEN System Reference Manual: September 1, 2003 Glossary of Terms � 67 



Subscreen


A subscreen is an area beneath the subtab where variables are presented. A subtab represents a 
subscreen. The variables on the subscreen are displayed by selecting a subtab. 

Tab/Subtab


A tab/subtab indicates the screen labels (e.g., Tab Discharge  is the tab that is used for retrieving the 
Discharge screen). 

Validation


The process by which the integrity and correctness of data are established. Validation processes can 
occur immediately after a data item is collected or after a complete set of data is collected. 

Variable


A variable is a data entry field that accepts data according to the specifications and rules indicated by the 
designer during the design. 

Variable Type


Variable types and attributes determine the type of data the system will accept (e.g., a variable will accept 
date format, etc.) during the data entry. The designer defines a variable type for each variable. For 
example, if variable Admission Date  accepts only data that are in date form, the variable type must be 
defined as variable type Date. 
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